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Preface

Preface

Sensors are devices or components that detect events or changes in their environments
and send information to other electronics, frequently to microcontroller systems. Sensors
are used in everyday life, to measure such things as temperature, humidity, pressure, wind
and rain, touch, light levels, liquid levels, altitude, force, and many more.

Although some sensors have digital outputs, most sensors used in everyday life have analog
outputs, usually in the form of voltages that are proportional to a measured quantity. This
output voltage is normally fed to the input port of a microcontroller for processing. For ex-
ample, the output of an analog temperature sensor is connected to an analog input port (an
analog-to-digital converter) of a microcontroller. The microcontroller reads the temperature
as a digital value and converts it into real physical temperature, which is then displayed or
used to control the temperature of a machine or room.

This book is about using the sensors found in the sensor kit. Altogether, there are 40
sensors distributed with the kit. Some sensors provide analog outputs while others have
digital outputs, and some have both analog and digital outputs. The kit includes sensors to
measure temperature, humidity, atmospheric pressure, light intensity, and sound. There
are also 2 and 3 colour LEDs, tilt switches, magnetic switches, relay, reed switches, piezo
buzzer, button, joystick, obstacle detector, heartbeat sensor, analog-digital converter, volt-
age translator, vibrations switch, etc.

40 Sensors All-in-1 Kit

The book is intended to teach how to use sensors with the popular microcontroller develop-
ment systems: Arduino Uno, ESP32 DevKitC, and Raspberry Pi. Example projects are given
to show how to use the sensors with these microcontrollers. The programs can be modi-
fied for other microcontrollers, such as PIC, STM32, Banana Pi, CubieBoard, Beaglebone,
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etc. All the projects given in the book were built using a standard size breadboard, and
they were fully tested and were all working. The projects are described with the following
sub-headings:

e Project description
Aim of the project
¢ Block diagram
Circuit diagram

e Program listing

The operation of each sensor and each program listing are described in detail so that the
readers will have no difficulty in either constructing or expanding a given project. Some
projects make use of more than one sensor from the kit. It is recommended that readers
follow the projects in the given order since some of the software tools used in some projects
depend on the installation of these tools in an earlier project.

Full program listings of the projects with many comments are available at the Elektor web-
site of the book and readers should be able to copy and use these programs without having
to make modifications.

Arduino Uno and ESP32 DevKitC programs are based on using the Arduino IDE with the C
language. Raspberry Pi projects use the Python programming language. Although the Ar-
duino based projects specify Arduino Uno as the development board, these projects should
also work with other Arduino development boards, such as Arduino Mega, Arduino Nano,
etc.

I hope the readers find the book useful and enjoy experimenting with the various sensors.

Dogan Ibrahim
June 2019

e 12



Chapter 1 ¢ Arduino Uno hardware interface and project development

Chapter 1 e Arduino Uno hardware interface and
project development

1.1 Overview

In this book, we will use the Arduino Uno board in the Arduino based sensor projects. This
Chapter shows the location of the various components on the Arduino Uno board and also
describes the hardware interface to the external world. A simple project is given in this
Chapter to make the reader familiar with developing programs with the Arduino Uno. The
first program flashes a two colour LED alternately every second.

1.2 Arduino Uno board
Figure 1.1 shows the Arduino Uno board in close-up with the major components marked.
The pin definitions are as follows (see Figure 1.2).

AQ - A5: Analog input ports

0-13: Digital input/output ports

~3,~5,~6,~9,~10,~11: | PWM output ports

0,1: UART RX/TX pins. LEDs labelled TX, RX will flash when data
is transmitted or received respectively

GND: Power supply ground pin

5V: Regulated +5V output

3.3V: Regulated +3.3V output

Vin: Voltage input (instead of using Power In or USB). The

voltage must be in the range 7-12V. It is regulated to +5V
internally. This pin can also be used as a voltage output (if
power is supplied using Power In or USB port). The voltage
is a copy of the voltage supplied through Power In or the

USB port.

IORef: Used by external shield boards to know if they should
operate as +3.3V or as +5V devices

Power In: Power supply Barrel Jack pin (6V to 12V)

USB port: Power and data port (connect to computer)

User LED: Onboard LED connected to output port 13 (can be used for
testpurposes)

Notice that when the Arduino Uno is powered by the USB port (e.g. from a computer) the
maximum current capacity is around 400mA for the +5V pin and 150mA for the +3.3V
pin. When powered by an external source, the maximum current for the 5V pin is around
900mA and 150mA for the +3.3V pin. Any current drawn from the +3.3V goes through the
+5V pin. Therefore, you have to take this into account when powering external devices.

The absolute maximum current for any I/0 pin is specified as 40mA (it is however recom-
mended not to exceed 20mA). The absolute total current from all the I/O pins is 200mA.

e 13
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Analog
Digital Ports
Reference TX/RX ;Jit to13)
Indicator User ol
LED

Qutputs

UART

- &
¥
DIGITAL (PWM~) E &

UsB
Port

Power
Indicator

Icsp
16MHz pins
Crystal

Voltage [P M Tx e e i it S
Regulator Proassce

Power

10Rel: 5V Senal: Senal 1s allached to pins 0 and 1, and to
Vin: 7-12V DC mx the USB-Senal micrcontroller on board

The Uno has a second microconttoller on board
to hardle USB-to-serial communications.
This is the ICSP header for thal microcontroller

GPIO18 ADC4 SDA
GPIO19 ADC5 SCL

AREF
Gnd
GPIO13 SCK LED
10Ret GPIO12 M
£33V GPIO11 MOS!
W5V GPIO10 S
Gnd GPIC9
Gnd GPIO8
vin GPIO?
GPIO6
ADCO GPIO14 GPIOS
ADC1 GPIO1S GPIO4
ADC2 GPIO16 GPIO3 W INT1
ADC3 GPIO1Y GPIO2 INTO
SDA ADC4 GPIO8 GPIOT X
GPI0D RX

SCL ADCS GPIO19

Comm. ADC GPIO GPIO ADC Comm. PWM Intetrupts

Gnd  MOSI 45V

Figure 1.2 Arduino Uno pin layout

1.3 Arduino Uno program development
A nice feature of all Arduino boards is that they can all be programmed using the Arduino

IDE. The latest version of Arduino IDE can be downloaded from the following web site. At
the time of writing this book the latest version was 1.8.8:

https://www.arduino.cc/en/Main/Software

e 14


https://www.arduino.cc/en/Main/Software

Chapter 1 ¢ Arduino Uno hardware interface and project development

The steps to writing and upload a program to your Arduino Uno are as follows:
e Connect your Arduino Uno to the USB port of your computer
e Start the Arduino IDE on your computer
e Click Tools -> Board and select board type as Arduino/Gerduino Uno

¢ Click Tools -> Port and select the serial port that your Arduino Uno is connected
to

e Write and then save your program

¢ Click Sketch -> Verify/Compile to compile your program. Make sure there are
no compilation errors

e Click Sketch->Upload to upload the executable code to the program memory
of your Arduino Uno

Two example projects are given in the following sections to make the reader familiar
with the project development cycle using the Arduino Uno. It is assumed that the reader
has some background in basic electronics and also some working knowledge of writing a
high-level language.

1.4 Project - Flashing two colour LEDs

description: This is perhaps the easiest project you can design using your Arduino Uno. In
this project, a two colour LED with common cathode is connected to the Arduino Uno. The
LED colours are flashed alternately at a rate of one second.

Aim: The aim of this project is to show how to write, compile and upload a program to the
Arduino Uno. The project additionally shows how to use some of the I/O and timing func-
tions of the Arduino.

Sensor Used: Sensor KY-011 is used in this project. This sensor consists of a red and
green colour LED housed in a package with a common cathode terminal. The sensor and its
pins are shown in Figure 1.3. The sensor has 3 pins: red LED pin, green LED pin and GND
pin. The green LED pin is marked with letter S on the board for identification. An
LED is turned ON when logic 1 is applied to its pins. The basic specifications of this sensor
are as follows:

Operating voltage: 2.0V to 2.5V
Operating current: 10mA (depends on the required brightness)
Wavelength: green (571nm), red (644nm)

Luminous intensity (MCD): green (20-40), red (40-80)

e 15
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A
Green
:S?]—O Common Cathode
Red
LED

Figure 1.3 Sensor KY-011

Block diagram: The block diagram of the project is shown in Figure 1.4.

Arduino Uno

RED LED
GREEN LED

Figure 1.4 Block diagram of the project

Circuit diagram: The circuit diagram of the project is shown in Figure 1.5. The green and
red LED pins are connected to port pins 2 and 3 of the Arduino Uno respectively through
current limiting resistors. The GND pin is connected to Arduino Uno GND pin. The value of
the current limiting resistor is calculated as follows:

The high voltage of an output pin is 5V. The forward voltage across an LED is approximately
2.0V (for the red LED this is 1.8V, and for the green LED this is 2.8V). Assuming that the
forward current to the LED will be set to 10mA (reasonable brightness), then, the value of
the current limiting resistor is:

R = (5V - 2V) / 10mA = 300 ohm, use 330 ohm resistor (you can use smaller
value, e.g. 270 ohms for the green LED)

In Figure 1.5 the LED is operated in current sourcing mode where a high output from the
I/O pin drives the LED. The LED can also be operated in current sinking mode where the
other end of the LED is connected to +5V supply and not to the ground. In current sinking
mode, the LED is turned ON when the I/O pin is at logic low.

e 16
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Arduino UNO

330 KY-011

211G

3 330 R

1

GND =

Figure 1.5 Circuit diagram of the project

Construction: The project is constructed on a breadboard as shown in Figure 1.6. Jumper
wires are used to connect the KY-011 to digital port pins 2 and 3 and GND of the Arduino
Uno.

wm d
e ON 3
(1]

ARDUINO >
"

W jAmpdipu) N
WN)T MADE IN TTALY *

Figure 1.6 The project constructed on a breadboard
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Program listing: The program is called TWOCOLOUR and the listing is shown in Figure
1.7. At the beginning of the program, port pins 2 and 3 are assigned to the green LED and
red LED pins respectively. Inside the setup routine, port pins 2 and 3 where the LED pins
are connected to are configured as outputs. Inside the main program loop, the two colours
are turned ON and OFF alternately with a one-second delay between each output. Verify/
Compile to make sure that there are no errors and then Upload the program code to your
Arduino Uno. You should see the two colours flashing at a rate of one second.

It is highly recommended by the author to comment the lines in your program and describe
the operation being performed as shown in Figure 1.7. You should also include a heading
and describe what the program does briefly. This makes it easier to understand and main-
tain the program at a later date. It also makes it easier for anyone else to understand the
logic of the program when they read it.

/******************************************************************
* FLASHING GREEN AND RED LEDs

* B

*

* In this program the KY-011 sensor is used which has a green and
* a red LED with a common cathode terminal. The green LED and the
* red LED are connected to I/O pins 2 and 3 of the Arduino Uno

* respectively. The program flashes the LEDs alternately at a rate
* of one second.

* Author: Dogan Ibrahim

* Date : April 2019

* File : TWOCOLOUR
******************************************************************/
int GreenLED = 2; // Green LED pin

int RedLED = 3; // Red LED pin

#define ON HIGH

#define OFF LOW

void setup()

{
pinMode (GreenLED, OUTPUT); // Set as output
pinMode (RedLED, OUTPUT); // Set as output

void loop()

{
digitalWrite(GreenLED, ON); // Turn ON green
digitalWrite(RedLED, OFF); // Turn OFF red
delay(1000); // Wait 1 sec
digitalWrite(GreenLED, OFF); // Turn OFF green
digitalWrite(RedLED, ON); // Turn ON red

e 18
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delay (1000); // Wait 1 sec
Figure 1.7 Program listing of the project

What we have learned: In this project, we have learned how to use the following Arduino
functions:

int: declares an integer variable

#define: assigns value or text to a string

pinMode (port pin, mode): used to configure an I/0 port pin as input or
output

digitalWrite(port pin, value): used to output digital value (logic LOW or HIGH)
to a port pin
delay(n): creates a delay of n milliseconds

1.5 Summary

In this Chapter, we have seen the various components and the pin definitions of the Arduino
Uno microcontroller. Additionally, a simple project is given to demonstrate how to design
simple projects and also how to compile upload the program code to the program memory
of the Arduino Uno microcontroller.

In the next Chapter, we will be looking at how to use the Raspberry Pi microcontroller in
projects.

e 19
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Chapter 2 e Raspberry Pi hardware interface and
project development

2.1 Overview

In this book, we will be using a Raspberry Pi 3 Model B in our Raspberry Pi projects. This
Chapter shows the location of the various components on the Raspberry Pi board and also
describes the hardware interface to the external world. Setting up Wi-Fi and remote access
to your Raspberry Pi computer, and becoming familiar with the Python programming envi-
ronment are also described briefly. A simple project is given to familiarize the reader with
the steps of designing a project. In this book, when we write Raspberry Pi 3 we actually
mean Raspberry Pi 3 Model B.

2.2 The Raspberry Pi 3 board
Figure 2.1 shows the Raspberry Pi 3 board with the major components marked. Some de-
tails on each component are given in this section.

-+—— USB ports

BCMA43438

Ethernet
And Wi-Fi

SD card & €Sl Audio/Video
slot R HDMI

USB power

Figure 2.1 Raspberry Pi 3 board

USB ports: Raspberry Pi 3 has 4 USB ports to connect a mouse, key-
board, webcam, etc.

Ethernet and Wi-Fi: Although the Raspberry Pi 3 has built-in Wi-Fi, it can also
directly be connected to a router through an Ethernet cable
connected to this socket.

Audio/Video Jack: A headphone or a speaker can be connected to this 3.5mm
socket. This socket also carries a composite video inter-

face.

CSI: This is the Camera Serial Interface where a compatible
Raspberry Pi camera can be attached here.

HDMI: A suitable monitor can be connected to this port. The port
carries both audio and video signals.

USB power: A +5V 2A power supply should be connected to this USB

socket to provide power to the Raspberry Pi 3.
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SD card slot: A micro SD card carrying the operating system must be
attached to this slot.

DSI: A suitable display can be connected to this Display Inter-
face connector.

SOC: This is the Broadcom BCM2837 System On Chip (SOC)

which contains the 1.2GHz 64-bit quad-core ARM Cor-
tex-A53 processor.

GPIO: The General Purpose Input-Output port is 40 pins wide.
BCM43438: This chip provides the Wi-Fi and Bluetooth to the Raspber-
ry Pi 3.

2.3 Raspberry Pi 3 GPIO pin definitions

The Raspberry Pi 3 is connected to external digital electronic circuits and devices using its
GPIO (General Purpose Input Output) port connector. This is a 2.54mm, 40-pin expansion
header, arranged in a 2x20 strip as shown in Figure 2.2.

1

3

5

7 8 GPIO14
9 10 GPIO15
1 12 GPIO18
13 14

15 16 GPIO23
17 18 GPIO24
19 20

21 22 GPIO25
23 24 GPIOB
25 26 GPIO7
27 28 DNC
29
31
33
35
37
39

36 GPIO16
38 GPIO20
40 GPIO21

UM \V M GND

Figure 2.2 Raspberry Pi 3 GPIO pins

When the GPIO connector is at the far side of the board, the pins at the bottom, starting
from the left of the connector are numbered as 1, 3, 5, 7, and so on, while the ones at the
top are numbered as 2, 4, 6, 8 and so on.

The GPIO provides 26 general purpose bi-directional I/O pins. Some of the pins have mul-
tiple functions. For example, pins 3 and 5 are the GPIO2 and GPIO3 input-output pins
respectively. These pins can also be used as the 12C bus I2C SDA and I12C SCL pins respec-
tively. Similarly, pins 9,10,11,19 can either be used as general purpose input-output, or as
the SPI bus pins. Pins 8 and 10 are reserved for UART serial communication.

Two power outputs are provided: +3.3V and +5.0V. The GPIO pins operate at +3.3V logic

levels (not like many other computer circuits that operate with +5V). A pin can either be
an input or an output. When configured as an output, the pin voltage is either 0V (logic
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0) or +3.3V (logic 1). Raspberry Pi 3 is normally operated using an external power supply
(e.g. a mains adapter) with +5V output and minimum 2A current capacity. A 3.3V output
pin can supply up to 16mA of current. The total current drawn from all output pins should
not exceed the 51mA limit. Care should be taken when connecting external devices to the
GPIO pins as drawing excessive currents or short-circuiting a pin can easily damage your Pi.
The amount of current that can be supplied by the 5V pin depends on many factors such as
the current required by the Pi itself, current taken by the USB peripherals, camera current,
HDMI port current, and so on.

When configured as an input, a voltage above +1.7V will be taken as logic 1, and a voltage
below +1.7V will be taken as logic 0. Care should be taken not to supply voltages greater
than +3.3V to any I/O pin as large voltages can easily damage your Pi. The Raspberry Pi 3,
like others in the family, has no over-voltage protection circuitry.

2.4 Setting up the Wi-Fi and remote access

It is very likely that you will want to access your Raspberry Pi 3 remotely from your desk-
top or laptop computer. The easiest option here is to enable Wi-Fi on your Pi computer and
then access it from your computer using the SSH client protocol. This protocol requires a
server and a client. The server is your Pi computer and the client is your desktop or laptop
computer. In this section, we will see how to enable the Wi-Fi on your Pi computer and how
to access it remotely.

Setting up Wi-Fi
To enable the Wi-Fi on your Pi, the steps are as follows:

e Click on the Wi-Fi icon which is a pair of red crosses at the top right-hand side
of the screen

e Select your Wi-Fi router from the displayed list (see Figure 2.3)

3 T o - 0149

Turn Off Wi-Fi

XN

BTWifi-with-FON
BTWifi-X B
Chromecast7872.b
HP-Print-19-LaserJet 200 color
The Hotal ]

Figure 2.3 Select your Wi-Fi from the list

e Enter the password for your Wi-Fi router
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e The WiFi icon should become a typical Wi-Fi image. If you click on the icon now
you should see a green tick next to the selected router as shown in Figure 2.4.
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Turn Off Wpl
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HP-Print-19-LaserJet 200 color 1
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Figure 2.4 Connected to the Wi-Fi successfully

e To see the IP address of your Wi-Fi connection, place the mouse over the Wi-Fi
icon as shown in Figure 2.5. In this example, the IP address was 192.168.1.84

BTWifi-with-FON

BTWifi-X ]
Chromecast7872.b
HP-Print-19-LaserJet 200 color
The Hotal &

Figure 2.5 IP address of our connection
Remote Access
The program we will be using to access our Raspberry Pi 3 is called Putty with the SSH
protocol. The steps to download and use Putty are as follows:
¢ Download Putty from the following link (or search Google for "Download Putty")
http://www.chiark.greenend.org.uk/~sgtatham/putty/download.html
e For security reasons, the SSH protocol is disabled by default on a new operat-

ing system. To enable it, click on the Applications menu at the top left of the
screen, click Accessories, and then click Terminal (see Figure 2.6)
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Figure 2.6 Access the Terminal menu

¢ You should now be in the Raspberry Pi 3 command prompt. Type:

sudo raspi-config

¢ to go into the configuration menu and select Interface Options. Go down to P2
SSH and enable SSH as shown in Figure 2.7

Edit Tabs Help

Figure 2.7 Enable the SSH server

¢ Click <Finish> to exit the configuration menu. You should now be back in the
command mode, identified by the prompt:

pi@raspberrypi:~ $
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e Putty is a standalone program and there is no need to install it. Simply double
click to run it. You should see the Putty startup screen as in Figure 2.8.

ﬂ PuTTY Configuration R ]
Catsaoy T
=J- Session Basic options for your PuTTY session
o m Specify the destination you want to connect to
Cayboard Host Name (or IP address) Port
el I z
Features Connection type:
=1 Window ) Raw Teinet () Rlogin @ SSH () Senial |
Behar Load. save or delete a stored session
viour
Translations Saved Sessions
Selection
Colours Defaut |
e Cirpositn D [ Lo |
Dat ESP32
e e =
Tore !
Riogin
¥ SSH
Sacsl Close window on exit: |
D) Aways () Never @ Only on clean exit
|
|

Figure 2.8 Putty startup screen

e Make sure that the Connection type is SSH and enter the IP address of your
Raspberry Pi 3. Click Open as shown in Figure 2.9.

8 PuTTY Configuration i
Category:
- Session Basic options for your PuTTY session
7 Logging Speciy the destination you want to connect to
Host Name (or IP address) Pott
e 192.168.1.84] 2
Features Connection type:
| Window D Raw () Teinet () Rlogin @ SSH () Serial
Behar Load, save or delete a stored session
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Transiation Saved Sessions
|
Colours
Default
|| & comeain e (L toad ]
Data |espa2
e |
e
| Rlogin
#- SSH
| Sendl Close window on ext:
O Aways (O Never @ Onlyon clean extt
||
I

Figure 2.9 Enter the IP address

e The message shown in Figure 2.10 will be displayed on the PC screen the first
time you access the Raspberry Pi 3. Click Yes to accept this security alert.
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o =

The server's host key is not cached in the registry. You
have no guarantee that the server is the computer you
think it is.

The server's rsa2 key fingerprint is:

ssh-rsa 2048 de:71:8e:57:84:12:46:84:43:98:80:a7:5:ef:d8:14
If you trust this host, hit Yes to add the key to

PuTTY's cache and carry on connecting.

If you want to carry on connecting just once, without
adding the key to the cache, hit No.

If you do not trust this host, hit Cancel to abandon the |
connection.

Yes No | Cancel ‘
]|

Figure 2.10 Click Yes to accept

¢ You will then be prompted for the username and password. The default values
are:

Username: pi
Password: raspberry

o After a successful login, you should see the Raspberry Pi command prompt as in
Figure 2.11.

P pi@raspberrypi: ~ o | B -

Figure 2.11 Successful login

¢ To change your password, enter the following command:
passwd

¢ To restart the Raspberry Pi ZW enter the following command:
sudo reboot

¢ To shut down the Raspberry Pi ZW enter the following command. Never shut down
by pulling the power cable as this may result in the corruption or loss of files:
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sudo shutdown -h now

2.5 Shutting down or rebooting in GUI mod
You must always shut down your Pi computer properly. To shut down while in the GUI
mode, follow the steps given below:

¢ Click Applications menu (top left corner)
e Click Shutdown (see Figure 2.12)
e Click Shutdown (or Reboot as required)

& Office

. Intermnet
H Games
* Accessones

S-"nstdewn a

Figure 2.12 Shutdown or reboot in GUI mode

2.6 Remote access of the desktop

If you will be using your Raspberry Pi 3 with local keyboard, mouse, and monitor you can
skip this section. If on the other hand, you want to access your Desktop remotely over the
network, you will find that SSH services cannot be used. The easiest and simplest way to
access your Desktop remotely from a computer is by installing the VNC (Virtual Network
Connection) client and server. The VNC server runs on your Pi and the VNC client runs on
your computer. The steps to install and use the VNC are given below:

e Connect to your Pi computer using SSH as explained earlier. Then enter the fol-
lowing command to install a program called TightVNC server on your Pi comput-

er. You will see many lines of messages. Make sure there are no error messages:

sudo apt-get update
sudo apt-get install tightvncserver
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e Run the VNC server on your Pi computer by entering the following command:

vncserver :1

¢ You will be prompted to enter and verify a password. This will be the password
you will be using to access the Desktop remotely (see Figure 2.13).

Figure 2.13 Enter a password for the VNC server

e The VNC server is now running on your Pi computer. The only command you need
to enter on your Pi computer to start the VNC server is:

vncserver :1

e We must now set up a VNC client on our laptop (or desktop). There are many
VNC clients available, but the recommended one which is compatible with Tight-
VNC is the VNC Viewer, which can be downloaded from the following link. Notice
that this program is not free of charge, but a 30-day free trial version is available.
You should register to get a trial license and then apply this license to the soft-
ware to use free of charge for 30 days:

http://www.realvhc.com
Download the VNC Viewer program into a suitable directory on your computer.
Double click to install it and enter the required license. Start the VNC Viewer

program by double-clicking its icon in your desktop. Enter the IP address of your
Raspberry Pi 3 followed by 1 as shown in Figure 2.14 and click Connect.
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|
VNC® Viewer 2
VNC Server: [192.168.1.84:1 -
Encryption: [Let VNC Server choose v]
{ About... ] [ Options... ]

Figure 2.14 Enter the IP address

Enter the password selected previously. You should now see the Raspberry Pi 3 Desktop
displayed on your laptop (or desktop) computer as in Figure 2.15 and you can access all of
the Desktop applications remotely.

Wi pi's X daskrop (raspbenypiL) - VNC Viewsr T — — el
O IeT EX:) 3 % =

Figure 2.15 Raspberry Pi 3 Desktop displayed on the laptop

2.7 Creating and running a Python program

We will be programming our Raspberry Pi 3 using the Python programming language. It is
worthwhile to look at the creation and running of a simple Python program on our Pi com-
puter. In this section, we will display the message Hello From Raspberry Pi 3 on our PC
screen.

As described below, there are 3 methods that we can create and run Python programs on
our Raspberry Pi 3:

Method 1 - Interactively from Command Prompt

In this method, we will log in to our Raspberry Pi 3 using the SSH and then create and run
our program interactively. This method is excellent for small programs. The steps are as
follows:

e 29



The Ultimate Compendium of Sensor Projects

e Login to the Raspberry Pi 3 using SSH

e At the command prompt enter python. You should see the Python command
mode which is identified by three characters >>>

e Type the program:
print ("Hello From Raspberry Pi 3")

¢ The required text will be displayed interactively on the screen as shown in Figure
2.16

lpi@raspberrypi:~ § python

Python 2.7.13 (default, Jan 19 2017, 14:48:08)

[GCC 6.3.0 20170124] on linux2

iType "help"”, "copyright", "credits" or "license" for more information.
|>>> print ("Hello From Raspberry Pi 3")

‘Hello From Raspberry Pi 3

>>> 1

Figure 2.16 Running a program interactively

Method 2 - Create a Python File in Command Mode

In this method, we will log in to our Raspberry Pi 3 using the SSH as before and then cre-
ate a Python file. A Python file is simply a text file with the extension .py. We can use a
text editor, e.g. the nano text editor to create our file. In this example, a file called hello.
py is created using the nano text editor. Figure 2.17 shows the contents of file hello.py.
This figure also shows how to run the file under Python. Notice that the program is run by
entering the command:

>>> python hello.py

Figure 2.17 Creating and running a Python file
Method 3 - Create a Python File in GUI mode
In this method, we will log in to our Raspberry Pi 3 using the VNC and create and run our
program in GUI mode. The steps are given below:

¢ Click Applications menu

e Click Programming and select Python 2 or Python 3 (see Figure 2.18)
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Figure 2.18 Select Python 2 programming

You should see the Python command mode, identified by characters >>>

Click File and then click New File and write your program

Save the file by giving it a name (e.g. hello2)

Run the program by clicking Run and then Run Module as shown in Figure 2.19

hello2.py - /home/pi/h

File Edit Format Run | Options Window Help
print ("Hello | Python Shell 1 Zero W")

Check Module  AltsX X
Run Module F5

Figure 2.19 Run the program

¢ A new screen will be shown with the output of the program displayed as in Figure

Python 2.7.13 Shell =

File Edit Shell Debug Options Window Help

|Python 2.7.13 (default, Jan 19 2017, 14:48:08)

i [6CC 6.3.0 20170124] on linux2
|| Type "copyright", "credits" or "license()" for more information.

| >>>

RESTART: /home/pi/hello2.py

|Hello From Raspberry Pi Zero W

35>

Figure 2.20 Output of the program
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Which Method?

The choice of a method depends upon the size and complexity of a program. Small pro-
grams can be run interactively without creating a program file. Larger programs can be
created as Python files and then they can run either in the command mode or in the GUI
mode. In this book, program files are created for all the Python programs.

2.8 The GPIO library

The GPIO library is called RPi.GPIO and it should already be installed on your Raspberry
Pi 3. This library must be included at the beginning of your Python programs if you will be
using the GPIO functions. The statement to include this library is:

import RPi.GPIO as GPIO

If you get an error while trying to import the GPIO library then it is possible that the library
is not installed. Enter the following commands while in the command mode (identified by
the prompt pi@raspberrypi:~ $) to install the GPIO library (characters that should be
entered by you are in bold):

pi@raspberrypi: ~ $ sudo apt-get update
pi@raspberrypi: ~ $ sudo apt-get install python-dev
pi@raspberrypi: ~ $ sudo apt-get install python-rpi.gpio

The GPIO provides a number of useful functions. The available functions are given in the
next sections

2.8.1 Pin numbering

There are two ways that we can refer to the GPIO pins. The first is using the BOARD num-
bering, where the pin humbers on the GPIO connector of the Raspberry Pi 3 are used. Enter
the following statement to use the BOARD method:

GPIO.setmode(GPIO.BOARD)

The second numbering system, also known as the BCM method is the preferred method
and it uses the channel numbers allocated to the pins. This method requires that you know
which channel humber refers to which pin on the board. In this book, we will be using this
second method. Enter the following statement to use the BCM method:

GPIO.setmode(GPIO.BCM)

The GPIO is a 40 pin header, mounted at one side of the board. Appendix A shows the
Raspberry Pi 3 GPIO pin configuration.

2.8.2 Channel (I/0 port pin) configuration

Input Configuration

You need to configure the channels (or port pins) you are using whether they are input or
output channels. The following statement is used to configure a channel as an input. Here,
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channel refers to the channel number based on the setmode statement above:
GPIO.setup(channel, GPIO.IN)
When there is nothing connected to an input pin, the data at this input is not defined. We
can specify additional parameters with the input configuration statement to connect pull-up
or pull-down resistors by software to an input pin. The required statements are:
For pull-down:
GPIO.setup(channel, GPIO.IN, pull_up_down=GPIO.PUD_DOWN)
For pull-up:
GPIO.setup(channel, GPIO.IN, pull_up_down=GPIO.PUD_UP)
We can detect an edge change of an input signal at an input pin. Edge change is when
the signal changes from LOW to HIGH (rising edge), or from HIGH to LOW (falling edge).
For example, pressing a push-button switch can cause an edge change at the input of a
pin. The following statements can be used to wait for an edge of the input signal. These
are blocking functions. i.e. the program will wait until the specified edge is detected at the
input signal. For example, if this is a push-button, the program will wait until the button is
pressed:
To wait for a rising edge:
GPIO.wait_for_edge(channel, GPIO.RISING)
To wait for a falling edge:

GPIO.wait_for_edge(channel, GPIO.FALLING)

We can also wait until either a rising or a falling edge is detected by using the following
statement:

GPIO.wait_for_edge(channel, GPIO.BOTH)
We can use event detection function with an input pin. This way, we can execute the event
detection code whenever an event is detected. Events can be rising edge, falling edge, or
change in either edge of the signal. Event detection is usually used in loops where we can
check for the event while executing other code.

For example, to add rising event detection to an input pin:

GPIO.add_event_detect(channel, GPIO.RISING)
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We can check whether or not the event occurred by the following statement:

If GPIO.event_detected(channel):

Event detection can be removed by the following statement:
GPIO.remove_event_detect(channel)

We can also use interrupt facilities (or callbacks) to detect events. Here, the event is han-
dled inside a user function. The main program carries on its usual duties and as soon as
the event occurs the program stops whatever it is doing and jumps to the event handling
function. For example, the following statement can be used to add interrupt based event
handling to our programs on rising edge of an input signal. In this example, the event han-
dling code is the function named MyHandler:

GPIO.add_event_detect(channel, GPIO.RISING, callback=MyHandler)

We can add more than one interrupt by using the add_event_callback function. Here the
callback functions are executed sequentially:

GPIO.add_event_detect(channel, GPIO.RISING)
GPIO.add_event_callback(channel, MyHandlerl)
GPIO.add_event_callback(channel, MyHandler2)

When we use mechanical switches in our projects we get what is known as the switch
bouncing problem. This occurs as the contacts of the switch bounce many times until they
settle to their final state. Switch bouncing could generate several pulses before it settles
down. We can avoid switch bouncing problems in hardware or software. GPIO library pro-
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vides a parameter called bouncetime that can be used to eliminate the switch bouncing
problem. An example use of this parameter is shown below where the switch bounce time
is assumed to be 10ms:

GPIO.add_event_detect(channel,GPIO=RISING,callback=MyHandler,
bouncetime=10)

We can also use the callback statement to specify the switch bouncing time as@
GPIO.add_event_callback(channel, MyHandler, bouncetime=10)

To read the state of an input pin we can use the following statement:
GPIO.input(channel)

Output Configuration

The following statement is used to configure a channel as an output. Here, channel refers

to the port humber based on the setmode statement described earlier:

GPIO.setup(channel, GPIO.OUT)

We can specify a value for an output pin during its setup. For example, we can configure a
channel as output and at the same time set its value to logic HIGH (+3.3V):

GPIO.setup(channel, GPIO.OUT, initial=GPIO.HIGH)

To send data to an output port pin we can use the following statement:
GPIO.output(channel, value)

Where value can be 0 (or GPIO.LOW, or False), or 1 (or GPIO.HIGH, or True)

At the end of the program, we should return all the used resources to the operating system.
This is done by including the following statement at the end of our program:

GPIO.cleanup()

2.9 Raspberry Pi project development cycle

The project development cycle, in general, includes both hardware and software develop-
ment. In simple projects where there is no external hardware used, we can simply use the
Raspberry Pi board as it is and only software development is then required. Most projects,
however, are more complex and require additional external components, such as LEDs,
motors, displays, keypads, etc. The developer then has the tasks of making sure that the
hardware is set up correctly and is in full working order before any software development
is started. If the hardware is not set up correctly then time will be wasted trying to develop
the software. Hardware development may require additional skills such as the familiarity
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with interfacing and correctly using various electronic components in microcontroller based
systems.

The project development cycle, especially the software development cycle is an iterative
process where the programmer may have to go back and keep making changes to the code
until the required response is obtained from the system under development. There are
various tools that can be helpful during the development of a project. For example, Flow
Charts, Program Description Language (PDL), UML, State Machines, and many other tools
can be used during the development cycle.

In Raspberry Pi projects in this book, we will be using the Python programming language.
Python is a very powerful interactive programming language that is taught as the first pro-
gramming language in many universities and colleges around the world. Python is available
on the Raspberry Pi computers and it supports a large number of libraries that simplify the
programming task considerably.

In the remainder of this Chapter, we will design a simple project using the KY-011 two col-
our LED board as in the previous Chapter.

2.10 Project - Flashing two colour LEDs

Description: This is perhaps the easiest project you can design using your Raspberry Pi.
In this project, a two colour LED with common cathode is connected to the Raspberry Pi.
The LED colours are flashed alternately at a rate of one second.

Aim: The aim of this project is to show how to write and run a program on the Raspberry
Pi. The project additionally shows how to use some of the I/O and timing functions of the
Raspberry Pi.

Sensor Used: Sensor KY-011 is used in this project as in the previous Chapter. The sensor
and its pins are shown in Figure 1.3. The sensor has 3 pins: red LED pin, green LED pin, and
GND pin, where the green LED pin is marked with letter S on the board for identifi-
cation. An LED is turned ON when logic 1 is applied to its pins.

Block diagram: The block diagram of the project is shown in Figure 2.21.

Raspberry
Pi

RED LED

GREEN LED

Figure 2.21 Block diagram of the project

e 36



Chapter 2 e Raspberry Pi hardware interface and project development

Circuit diagram: The circuit diagram of the project is shown in Figure 2.22. The green and
red LED pins are connected to port pin GPIO 2 (pin 3) and GPIO 3 (pin 5) of the Raspberry
Pi respectively through current limiting resistors. The GND pin is connected to Raspberry Pi
GND pin. The value of the current limiting resistor is calculated as follows:

The output high voltage of a GPIO pin is 3.3V. The voltage across an LED is approximately
2.0V (for red LED this is 1.8V, and for green LED 2.8V). The forward current through the
LED depends upon the type of LED used and the amount of required brightness. Assuming
that we choose 5mA of forward current, the value of the current limiting resistor is (the LED
brightness can be increased by increasing the forward current):

R = (3.3V - 2V) / 5mA = 260 ohm. We can choose 220-ohm resistors to give
around 6mA forward currents for each LED (for green LED you can use smaller
value, e.g. 150 ohms)

Raspberry Pi

KY-011
GPIO2 G

crio3P—22% (R
GND
T 1

Figure 2.22 Circuit diagram of the project

Construction: The project is constructed on a breadboard as shown in Figure 2.23. Jumper
wires are used to connect the KY-011 to digital port pins 2 and 3 and GND of Raspberry Pi.

Figure 2.23 Project constructed on a breadboard
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Program listing: The program is called rpitwoled.py and the listing is shown in Figure
2.24. At the beginning of the program, libraries RPi.GPIO and time are imported into the
program. Green and red LED pins are assigned to port GPIO port numbers 2 and 3 respec-
tively. The LEDs are then configured as outputs. The remainder of the program runs in an
endless loop. Inside this loop, the green and the red LEDs are flashed alternately with a
one-second delay between each output.

You can run the program from the command line by entering the following command (char-
acters entered by the user are in bold for clarity):

pi@raspberrypi:~ $ python rpitwoled.py

#
#
#
# In thiS project the two colour LED KY-011 s used. The

# green and red LED pins are conncted to Raspberry Pi port
# pins GPIO2 and GPIO3. The LEDs flash alternately with a
# rate of one second

#

#

#

#

Author: Dogan Ibrahim
Date : April 2019
File : rpitwoled.py

o
import RPi.GPIO as GPIO # import Rpi library

import time # dimport time library
GPIO.setwarnings(False) # disable warnings
GPIO.setmode(GPIO.BCM) # set BCM mode

GreenlLED = 2 # green LED

RedLED = 3 # red LED

ON =1

OFF = 0

GPIO.setup(GreenLED, GPIO.OUT) # Configure as output
GPIO.setup(RedLED, GPIO.OUT) # configure as output

do forever
green LED ON
red LED OFF
wait 1 second
green LED ON
red LED ON
wait 1 secons

while True:
GPIO.output(GreenLED, ON)
GPIO.output(RedLED, OFF)
time.sleep(1l)
GPIO.output(GreenLED, OFF)
GPIO.output(RedLED, ON)
time.sleep(1l)

BT R R

Figure 2.24 Program listing of the project
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Note: You may find it easier to create and run your Python programs from the GUI
desktop interface (IDLE 2) since the correct indentation is automatically placed in your
code as you type the code.

What we have learned: In this project, we have learned how to use the following Rasp-
berry Pi functions:

import: import a library module to the program

GPIO.setmode(mode): set the GPIO pin usage mode in the program

GPIO.setwarnings(mode): disable (False) or enable (True) warning mes-
sages

GPIO.setup(port pin, mode): set the pin mode as either input or output
GPIO.output(port pin, value): send value (0 or 1) to specified port pin
time.sleep(n): create a delay of n seconds

2.11 Summary

In this chapter we have looked at the pin configuration of the GPIO connector and how to
enable the Wi-Fi module and access the Raspberry Pi remotely from a desktop computer
or a laptop. Additionally, we have looked at the design of a simple KY-011 two colour LED-
based project using the Python programming language.

In the next Chapter, we will be looking at how to install the firmware on the ESP32 micro-
controller and how to use it in projects.
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181
317
299
156
241

20
225
228

89
13
201
114
114
139

192
194

102

228

146, 150

96, 180

141

136, 141
172, 186

62

100

16

100, 141, 158, 204
239, 255
270, 288, 291
73

73

81, 94

82, 94, 146, 150, 168

75, 96, 180
114, 131, 141
108

192

180



KY-025
KY-026
KY-028
KY-029
KY-031
KY-032
KY-033
KY-034
KY-035
KY-036
KY-037
KY-039
KY-040
KY-050
KY-051
KY-052
KY-053

L

LCD

LDR

Light projects
Line tracking

LM393

M

Magic light cup
Magic wand
Magnetic sensor
Matplotlib

Metal touch sensor
Millis

MISO

MOSI

Musical instrument

N
NEC code

o

Obstacle sensor
One-wire
On-off control

184

188

236
131, 297
147, 153
201
207, 211
76

185

204

168

225

217
156, 158
85, 94
260

85, 255

239
82
51

207

236

108

67
180
234
204
154
261
261
185

116

201
230
260

P
Parallel LCD
Parking

Photo interrupter
Piezzo buzzer
Playing melody
PowerIn

Pressure sensor
Pulse distance code
Pulse length code
Putty

PWM

Pylirc

R

Random

Raspberry Pi pin layout

Raspi-config

RC5

RealTerm

Reed switch

Remote access

Remote control

RGB LED

Rotary encoder

Rotary encoder direction
Rotary encoder position
ROYGBIV

S

Scanning TV channels
SCLK

Secret code

Secret key

Serial Bluetooth
Serial LCD

Serial monitor

Serial plotter

Shaft encoder

Sketch

Sound projects
Speed of sound

SPI bus

SS

SSH

Steinhart-Hart coefficients

240
156
101
172
172

13
228
115
115

23

51
126

71
21
89
116
249
76
23
279
62, 69
217
220
220
63

136
261
211
100
286
240
231
226, 232
218
15
168
157
261
261
24
239
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T
Target shooting 146
Temperature sensor 228
Thermistor 237
Thingspeak 291
TightVNC 27
Tilt switch 68
Timestamp 258
Tone 174
Tracking sensor 207
u

UDP 271, 290
UDP server 312
Ultransonic projects 156
\'}

Vibration and shock projects 146
Vncserver 28
W

Wi-Fi 270, 288, 307
Wi-Fi watch 313
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40+ Projects using Arduino, Raspberry Pi and ESP32

The Ultimate Compendium

of Sensor Projects

This book is about developing projects using the sensors kit
with Arduino Uno, ESP32, and Raspberry Pi microcontroller
development systems. All sensors in the sensor kit are used in
various projects in the book. The book explains in simple terms
and with tested and fully working example projects, how to use
the sensors provided in the sensor kit. The projects provided in
the book include the following:

e Changing LED brightness

* RGB LEDs

e Creating rainbow colours

¢ Magic wand

o Silent door alarm

e Dark sensor with relay

e Secret key

¢ Magic light cup

e Decoding commercial IR handsets
e Controlling TV channels with IT sensors
* Target shooting detector

e Shock time duration measurement
o Ultrasonic reverse parking

¢ Toggle lights by clapping hands

¢ Playing melody

e Measuring magnetic field strength
e Joystick musical instrument

e Line tracking

¢ Displaying temperature

e Temperature ON/OFF control

e Mobile phone-based Wi-Fi projects
* Mobile phone-based Bluetooth projects
¢ Sending data to the Cloud

The projects have been organized with increasing levels of
difficulty. Readers are encouraged to tackle the projects in the
order given. A specially prepared sensor kit is available from
Elektor. With the help of this hardware, it should be easy and
fun to build the projects in this book.
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